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Using this 
template  

The standard headings and tables in this template should be modified to meet the 
requirements of each Initial Assessment.  The sites may have diverse issues and 
constraints and problems and the standard template is therefore just a guide on 
typical requirements but flexibility is allowed to amend/ add headings as required 

 
 Hidden 
guidance  

The template contains various pieces of guidance covering content, use of tables 
etc.  The guidance is shown in blue text and can be turned ‘on’ to assist in the 
writing stages or ‘hidden’ for viewing or when printing the document.  You can 
switch between ‘hidden’ and ‘on’ and back to ‘hidden’ at any time. 

To show/hide the guidance click on the ¶ icon on the MS Word toolbar.  

If the hidden text does not disappear off the screen when the ¶ icon is clicked, go 
to:  Tools>Options>View Tab and uncheck the ‘Hidden text’ box.   

It is advisable to work with the hidden text turned on, as this helps to format new 
text and to avoid deleting the hidden text itself. 

 
Auto-
updating of 
contents 
page 

The contents page will update to reflect changed information in the main text and 
tables.  To update right click on the relevant area of the contents page, to highlight 
it, and select ‘Update Field” to access the update option. 

To enable these updating features to be created, the document contains specific 
text types and “fields”.  These are Headings 1, 2, 3 & 4; fields in the table labels 
and in the appendix labels.  When editing the document, take care to maintain 
these aspects. 

 
Inserting new 
headings  

To insert new headings in the main text go to: Format>Styles and Formatting to 
open the styles box. Insert the new headings, highlight it and click on the 
appropriate Heading level in the ‘Pick formatting to apply’ box.  Paragraph text 
can be inserted and formatted in a similar way. 

 
Inserting new 
tables  

Table labels should be added by Insert>Reference>Caption and selecting ‘Table’ 
from the drop down ‘Label’ box.  This will insert the Table title with the correct 
number and the caption can be typed in after the label.  Tables can then be cross 
referenced from the text by Insert>Reference>Cross Reference and selecting the 
appropriate reference type and caption from the drop down box and list. 

 
Numbering 
paragraphs  

All paragraphs should be numbered sequentially as sub-sets of the section 
number. Prompts for paragraph numbering are provided as ‘Start writing here’ 
after which pressing <return> will automatically provide the next paragraph 
number.  

 

Bradford Initial assessment report  
Apperley Bridge 
November 2016 
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1.1  Introduction and background 

1.1.1 Background 

In May 2016 CH2M were commissioned by the Environment Agency, on behalf of Bradford 
Metropolitan District Council, to undertake Yorkshire Area Initial Assessments report for 
Apperley Bridge providing guidance on measures to reduce flood risk and potential funding 
availability. Site visit for this Initial Assessment was undertaken on 18th July 2016. This report 
has been made based on information from the site visit and previous studies and reports that 
are relevant to this Initial Assessment. 

1.1.2 Description of Location 

Apperley Bridge is a village located in the north-east of the City of Bradford in West Yorkshire. 
The Leeds and Liverpool Canal and the River Aire run through the village. A location plan of the 
site is shown in Appendix G in Figure 1.  The area belongs to the River Aire at Esholt and 
Apperley Bridge Flood Warning Area. 

The study area is classified within the 80% most deprived area in the country.  There are no 
properties within the 10% most deprived classification. 

1.1.3 Description of Watercourses and Geology 

There are two watercourses within the study area; the River Aire flowing west to east and Carr 
Beck flowing south to north. 

The River Aire is a major watercourse in Yorkshire flowing from Malham in the Yorkshire Dales, 
through the urban areas of Bradford and Leeds, before joining the River Ouse at Airmyn.  The 
Aire is approximately 114km in length from its source to its confluence. 

The River Aire is a natural channel within the study area, with no formal flood walls or 
embankments.  There are two bridges crossing the River Aire in Apperley Bridge.  

Carr Beck is an ordinary watercourse, flowing south to north, and joins the River Aire adjacent 
to Waterloo Crescent.  The beck is culverted beneath the Leeds and Liverpool Canal and Parkin 
Lane before discharging into the River Aire as an open channel.  It is believed that a number of 
surface water drains discharge into Carr Beck from Apperley Bridge.   

The underlying bedrock of the Area of Apperley Bridge is Millstone Grit, overlain by lover coal 
measures. Ground condition could be described as freely draining slightly acid loamy soils. 

1.1.4 History of Flooding 

Apperley Bridge is prone to flooding and there have been a number of historical incidents.  
Apperley Bridge was flooded during the significant flood incidents that affected the Upper Aire 
Catchment in 2000, 2012 and 2015. 

The area located between the River Aire and Leeds and Liverpool Canal was flooded during the 
December 2015 flood incidents. There was a flood warning issued for that area on 12 and 25th 
of December 2015.  22 residential properties were flooded. 

Apart from December 2015, since 2000 there have been two other flood incidents in Apperley 
Bridge. During the October – November 2000 floods, due to prolonged heavy rainfall water 
levels at the River Aire were higher than any on record with return periods in excess of 100-
years. 6 properties were affected. 
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Another flood event took place in 2002, between July and August, when high water level at the 
Rvier Aire and surface water issues, caused flooding in Apperley Bridge. During 2 days the 
amount of rainfall was equivalent of two months average rainfall. 

Apperley Bridge also has a significant history of surface water flooding.  The surface water 
system currently discharges into the River Aire and Carr Beck. However, during times of high 
water levels in the River Aire, the drains cannot discharge and water backs up in the system 
and surcharges. 

 
 
1.1.5 Summary of modelling analysis 

In 2008 hydraulic and hydrological modelling of the Upper River Aire was completed by JBA to 
support the development of the Flood Risk Management Strategy. For this study the River Aire 
was modelled from High Hill Weir upstream of Gargrave to Fleet Weir downstream of Leeds. 
The Upper River Aire model is a 1D hydrodynamic ISIS model containing 1922 nodes. 

This 2008 study aimed to define flood risk within this area and identify potential flood risk 
management options. This informed the Flood Risk Management Strategy for the Upper Aire 
which proposed flood risk management options for the short, medium and long-term. These 
recommendations included proposals to progress a flood management scheme for defences at 
Apperley Bridge. 

1.1.6 Drivers, Constraints and Opportunities 

The study area falls under the Aire CFMP, and is covered by sub-area 3 - Worth and Aire. A link 
to the Aire CFMP can be found here: https://www.gov.uk/government/publications/river-aire-
catchment-flood-management-plan. The designated policy for the area at risk is Policy Option 5: 
Areas of moderate to high flood risk where we can generally take further action to reduce flood 
risk. 

The following drivers, constraints and opportunities have been identified within the study area.  

Political Drivers  Summary Description 

Catchment Flood Management Plan Aire CFMP 2010 

Catchment Flood Management Policy 

Policy 5 – Areas of moderate to high flood risk 

where we can generally take further action to 

reduce flood risk. 

Economic Drivers   Summary Description 

Funding Time Constraints 

Must be obtained within 6 year programme of 

capital investment 

Technological Drivers  Summary Description 

Improved Public Safety Via reduced flood risk 

Environmental Constraints  Summary Description 

Sites of Special Scientific Interest (SSSI) 

Leeds - Liverpool Canal SSSI - 1.9 kilometres to 

the east of area of interest  

Special Area of Conservation (SAC) Leeds - Liverpool Canal 

Ancient Woodland 

There is an ancient woodland called Calverley 

Wood 300 metres to the east/ south-east from 

Apperley Bridge 

Tree Preservation Orders 

There are some trees protected by TPO. If any 

work to trees within the designation will 

require written permission from the council 

prior to any works taking place on them. 
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Listed Buildings 7 listed buildings within the study area 

1.2 Problem and objectives 

1.2.1 Problem 

The site is at risk of fluvial flooding due from the River Aire and Carr Beck. There are 
approximately 60 properties at risk within the study area.  

There is also a known surface water flooding issue within the study area.  During times of high 
river levels the surface water drainage cannot discharge and backs up causing flooding to 
nearby properties. 

There are no formal flood defences walls or embankments at Apperley Bridge.  The farm land 
upstream of Apperley Bridge on the right bank is designated washland. 

Based on all the available information, EA had estimated that the December 2015 flood event 
has 1.3% – 1% annual exceedance probability (AEP). It means, that an event has between 1 in 
80 and 1 in 100 chance of occurring in any single year.  

During December 2015 flood event the peak water levels at the Kildwick gauge station was 
4.219m, just below the highest recorded level recorded which was for the 2000 flood event.   

 
1.2.2 Objectives 

The primary objective of this initial assessment is to undertake a scoping study in the area to 
identify the flood risk issues and viable solutions for the affected properties and to identify any 
other potential flood risk management measures which are consistent with the current CFMP 
policy. 

The purpose of this report is to lay the groundwork and, where applicable, provide a business 
case for future appraisal. The report aims to achieve the following: 

• Confirm the need for a project; 

• Identify the issues and Political, Environmental, Societal, Technological, Legislative 
and Economic (PESTLE) drivers and opportunities related to the need; 

• Identify the options to address the need and problem; 

• Demonstrate that viable options exist based upon the available information; 

• Provide sufficient information to allow the packaging and optimisation of packages of 
future appraisal, design and construction packages; 

• Provide sufficient information for the appraisal scope to be prepared; 

• Make an assessment on the deliverability of the project; 

• Provide a basis/starting point for discussion with communities and partner 
organisations for use in the development of potential schemes and negotiations 
regarding funding contributions. 

 

1.3 Benefits 
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In this area the primary benefit associated with a reduction in flood risk would be the reduction 
in economic damages to properties. This is turn would reduce disruption to local transport, 
businesses, private residences and other infrastructure.  

Social benefits relate primarily to a reduction in stress, health effects (including risk to life) and 
loss of memorabilia for those at risk. 

An appraisal period of 100 years is assumed, over which the current Standard of Protection of 
existing assets is expected to decrease as a result of climate change. 

 
 
Table 1.1 shows the properties at risk within the study area. 
 
Table 1.1 Number of Properties at Risk (based on current outlines) 

Property Type Flood Risk Number of 
Properties 

≥1 in 25 year (4% AEP) 
(Very Significant Risk) 

0 

<1 in 25 year (4% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

37 Residential  

<1 in 75 year (1.33% AEP)  
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

23 

≥1 in 25 year (4% AEP) 
(Very Significant Risk) 

0 

<1 in 25 year (4% AEP) 
≥1 in 75 year (1.33% AEP) 
(Significant Risk) 

1 Non-Residential 

<1 in 75 year (1.33% AEP) 
≥1 in 200 year (0.5% AEP) 
(Moderate Risk) 

1 

Detail of the methodology used for assessing the benefits of each option is detailed in Appendix 
C.  

1.4 Options 

A longlist of options has been compiled. The table on the following page shows the large range 
of longlist options considered and the reasoning for or against them being taken forward to the 
shortlist of options to be assessed. 
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Category Long List 
Option 

Water Course / 
Areas Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

Do nothing Do nothing  All operational and maintenance 
activities cease 

Yes Required to support development of 
business case and benefit cost ratios. 

Do minimum Do Minimum  Continue with current operational 
and maintenance activities.  

Yes Required to support development of 
business case and incremental b/c 
ratio. 

Non-structural 
(by EA) 

Improved flood 
warning 

 Enhanced flood warning to allow 
residents to prepare plus 
appropriate implementation of flood 
action plans 

No Not funded via the capital programme.  
A Flood warning system is already in 
place for Waterloo Crescent. 
Improving the current system would 
require further modelling which is 
beyond the scope of this study. 

Non-structural 
(by EA) 

Flood action 
plans 

 Improved direction of reactionary 
flood defence measure (fire crews, 
temporary pumps, etc.) 

No Apperley Bridge is already within a 
Flood Warning and Flood Alert area. 

Property level 
protection 

Property level 
protection 

 Protection to individual properties 
(e.g. via air brick covers, door 
guards etc).  

Yes Passive solutions to be considered as 
an option (flood doors, automatic 
airbricks) 

Operational 
(by Others) 

Improve 
operation/design  

 Improve operation/design of assets 
not owned by the EA 

No No third party assets affecting fluvial 
flood risk in the study area. 

Urban 
drainage 

Improve urban 
drainage. 

 Improved surface water drainage 
system. 

Yes Surface water caused flooding during 
the Dec 15 event due to high levels in 
the Aire.   

Structural Earth bunds  Flood bund  No Insufficient space at Waterloo Crescent. 

Structural Flood walls  Flood walls Yes It can be considered as an option as it 
could reduce the risk of flooding directly 
from the River Aire.  

Structural Conveyance  Channel deepening or widening No Shoal clearance was made - 300 
tonnes of stones and soil were removed 

Structural Conveyance  Supplementary bypass channel(s, No Insufficient space in Apperley Bridge for 
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Category Long List 
Option 

Water Course / 
Areas Affected 

Description Take Forward for 
assessment? 

Reasoning / Notes / Past Study 
Reference 

tunnels or floodway bypass channel. 

Structural Conveyance  River restoration and/or pinch point 
improvements (bridges, culverts 
and weirs) 

No No significant pinch points identified. 

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. 
(River Worth). 

Yes Online flood storage area North of 
Haworth. 
The Upper Aire SFRA identified two 
potential storage areas on the River 
Worth upstream of Keighley. Use of 
these sites would reduce peak flows in 
Keighley increasing the standard of 
protection provided by the Worth 
scheme. 

Flood storage 
area  

Online  Use of active structures and re-
profiling to store water online. 
(River Aire). 

Yes As part of the Leeds FAS Phase 2 
study upstream storage is being 
considered.  The storage being 
proposed can potentially deliver further 
benefits to Bradford 

Flood storage 
area 

Offline  Gravity or pumping to offline 
storage area 

No Majority of flooding not from the river, 
reduction of flow volume is not 
necessary. 

Floodplain 
storage 

Washlands-type 
scheme 

 Enhance/increase natural floodplain 
attenuation with cascade of passive 
storage areas in existing floodplain 

Yes The playing fields opposite Waterloo 
Crescent could be used for floodplain 
storage. Also there is the opportunity for 
flood storage upstream of Apperley 
Road. 
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1.4.1 Shortlisted options description 

Do Nothing 

The Do Nothing option is defined as taking no action whatsoever; under this option all 
management activities would cease, including maintenance and repair work to existing assets. 

Under this assumption, the natural deterioration of the river channel will occur, leading to an 
increase in flood risk. There are no assets within the study area to be considered. 

There could be some advantages of this option in the form of habitat creation due to wetting of 
dry areas and naturalisation of channel, however, this is also likely increase the risk to people 
and wildlife. 

The Do Nothing option is not to be taken forward as a viable option as it results in an 
unacceptable increase in flood risk to people and property due to failure and deterioration of 
assets and blockages to the channel, however it is required to be assessed in order to develop 
the business case. 

Do Minimum 

The Do Minimum option is defined as the minimum level of action or intervention necessary to 
continue to maintain the current defences while feasible to do so. The Do Minimum does not 
include capital works and so reverts to do nothing once the defences fail or need upgrading.  

The current maintenance regime is simply a bi-annual site walkover, one in the summer and one 
in the winter to identify ad-hoc channel works.  No regular channel works are carried out. 

Option 1 – Property Level Protection 

This option considers providing property level protection measures for the properties that were 
affected by the December 2015 flood event. PLP can take the form of barriers in doorways, non-
return valves fitted to drains, and airbrick/vent covers. Properties can also be made more flood 
resilient, using waterproof plaster, solid concrete floors or tiled floor coverings in order to reduce 
the amount of time and money needed to recover from a flood event.  

The EA have requested the use of passive measures to maximise the effectiveness of the 
measures, ensuring the measure are installed at times of flooding. 

Property level protection prevents water entering the property but water will still retained by the 
building structure.  Furthermore, PLP does not provide any wider environmental benefits and 
does not prevent the flooding of areas surrounding the property.  It is assumed that the option will 
offer a 1.3% (1 in 75 year) AEP standard of protection. 

There are currently no properties in the very significant flood risk category, therefore this option 
will not be eligible for FDGiA funding. 

Option 2– Improvements to urban drainage 

There are known drainage issues in Apperley Bridge, especially around the confluence of the 
River Aire and Carr Beck.  Anecdotal evidence suggests that the surface water flooding is caused 
by high water levels in the River Aire preventing the system discharging.   

There is not enough information on the existing drainage assets to be able to fully assess the 
flood risk at this time but it is recommended that this option is considered in further studies.  
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Potential solutions could range from relatively cheap options like installing flap valves to prevent 
river water backing up into the drainage system to more expensive options like increasing system 
capacity by oversizing pipes or installing a pumping station or alternatively by providing 
attenuation using SuDS measures. 

Option 3 – Linear Defence 

This option involves the construction of linear flood defence along the right bank of the River Aire, 
tying into the high ground of the Leeds and Liverpool Canal embankment.  The defence 
alignment will also need to run along both banks of Carr Beck, from the confluence with the Aire 
to the culvert under the canal, to prevent water backing up from the Aire and overtopping the 
beck’s bank.   

The flood defence will be formed of a flood wall along the banks of Carr Beck and the River Aire 
due to space constraints but an earth embankment can be used to cross the playing fields to tie 
into the canal embankment. 

Limited water level data is available for this assessment, therefore a nominal defence height of 
1m was assumed for this option, further analysis will be required to refine the defence height if 
the option is carried forward. 

A plan of the proposed linear defence location is shown in Appendix G – Figure 2. 

This option is a permanent structure and does not require operation. The defence offers a 1% (1 
in 100 year) AEP standard of protection, this will move the properties to the moderate risk band. 
Note it could be optimised to provide other standards in a more detailed assessment. 

Further modelling would be required in order to assess the impact of removal of flood plain due to 
the construction of this flood bund on communities further downstream. Compensatory flood plain 
storage may be required, adding to the costs of the scheme. It must be ensured that the 
compensatory storage is hydraulically linked to the flood plain lost, otherwise the benefits from it 
may not be fully realised.  

Option 4 – Flood storage areas (River Worth) 

The 2014 Upper Aire SFRA identified a site near Lord Lane north of Haworth that could 
potentially be used as a flood storage area. This option provides a reduction in flood risk from the 
River Aire further downstream. The SFRA estimated the use of this area could potentially result in 
a 7% reduction in peak Aire flow and a 50mm reduction in flood depths in Leeds. 

The impact of this storage area on Apperley Bridge will be to reduce flood risk however 
significance of the impact is uncertain.  This option can be used in conjunction with other options, 
for example reducing the scale of flood defences.   

The scheme will also provide a reduction in flood risk beyond the study.  As a result the benefit-
cost ratio for the option will be artificially low, being limited to the Apperley Bridge benefits.  
Therefore the economic analysis for the option is not presented in this report but the option 
should be considered in any future studies. 

Option 5 – Flood storage areas (River Aire) 

The Leeds FAS Phase 2 scheme has identified three locations that could be potentially used as 
flood storage areas; Keighley Holden Park, Marley Bridge and Rodley.  The Rodley site is 
downstream of our study area but the other two sites could potentially provide benefits for 
Apperley Bridge.  The Upper Aire FRMS has estimated a reduction of 300mm to 400mm for a 1% 
(1 in 100 year) AEP event at Leeds Station.  The impact at Apperley Bridge, however, is 
uncertain but is expected to have significant impact on peak water levels. 
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The scheme will also provide a reduction in flood risk beyond the study boundaries for this Initial 
Assessment.  As a result the benefit-cost ratio for the option will be artificially low, being limited to 
the Apperley Bridge benefits.  Therefore the economic analysis for the option is not presented in 
this report but the option should be considered in any future studies. 

 

 

Option 6 – Floodplain storage 

This option considers maximising the potential floodplain storage.  There are currently two 
designated washland sites identified by the EA; the sports ground on the left bank and the 
agricultural land upstream of the site on the right bank.  

The proposal is to lower the existing ground level of these washland areas to allow the areas to 
fill earlier and store a larger quantity of floodwater, reducing the water levels. The agricultural land 
upstream of the study area is significantly larger than the sports ground and will cause a greater 
reduction in water levels and has been selected as the preferred site for the storage area.  The 
option is to reduce the existing levels of the site by 1m and creating circa 131,000m3 additional 
storage.  It is assumed that the option will offer a 1.3% (1 in 75 year) AEP standard of protection. 

A plan of the proposed floodplain storage area location is shown in Appendix G – Figure 3. 

This option requires testing in the hydraulic model to confirm its viability and effectiveness. The 
option is technically feasible however there are risks associated with gaining land owner consent. 
The standard of protection provided by this scheme is highly uncertain until further modelling is 
carried out.  

1.4.2 Costs of options 

The costs for the options were calculated using the Environment Agency’s Project Cost Tool and 
Long Term Costing Workbook. The maintenance and operation costs relate to mechanical 
maintenance of the assets to Target Condition 3. 

It is assumed that a major replacement of assets will be required at some point during the 
appraisal period after the initial construction phase. The timing of these replacements is based on 
the EA’s Asset Deterioration Guidance (2013), and the assumptions are outlined in Appendix B.  

An appraisal period of 100 years has been used. A detailed breakdown of costs across this 
period is included in Appendix B. 

Table 1.2 shows the build-up of costs for all options. 

Table 1.2 Project costs (£k) 

Item Do 
Minimum Option 1 Option 3 Option 6 

Construction Costs  240 2,290 5,710 

Environment Agency staff  40 170 220 

Consultant fees (appraisal)  20 120 130 

Consultant fees (design)  60 330 630 
Consultant fees 
(construction) 

 
0 140 230 

Site investigation & survey  0 90 40 

Land purchase  0 20 60 

Optimism Bias (44%)  160 1,380 3,100 
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Item Do 
Minimum Option 1 Option 3 Option 6 

TOTAL  510 4,520 10,130 
Annual Operation and 
Maintenance Costs 
(includng optimism bias) 

1.1 1.1 1.5 1.1 

There are insufficient data on the existing surface water assets to be able determine the existing 
flood risk for Option 2, therefore the benefit-cost assessment has not be completed as part of this 
study but should be considered in future studies. 

The upstream storage options on the River Aire (Option 5) and River Worth (Option 4) will 
provide a reduction in flood risk beyond in Apperley Bridge and beyond the study boundaries for 
this Initial Assessment.  As a result the benefit-cost ratio for the option will be artificially low, being 
limited to the Apperley Bridge benefits.  Therefore the economic analysis for the option is not 
presented in this report but the option should be considered in any future studies. 

 

1.5 Initial environmental assessment 

The main impacts of each option are summarised in Table 1.3: 
 
Table 1.3  Key environmental impacts, mitigation and opportunities 

Key positive impacts Key negative impacts Mitigation/ enhancement 
opportunity 

Option 1 
Reduced risk of flooding. Option only protects properties 

and not surrounding land. 
 

Option 3  

Reduced risk of flooding. 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

Option 6  

Reduced risk of flooding. 

Construction work takes place 
alongside watercourse. Risk of 
pollution incidents and disruption 
to area during construction. 

Best practice should be followed 
including referring to EA Pollution 
Prevention Guidance. 

 
 

1.6 Consultation 

The options in this appraisal were developed in consultation with the Environment Agency and 
Bradford MDC. No public consultations were held at this stage as the work is a high-level 
assessment of potential options. Stakeholder engagement will take place at subsequent stages of 
the project. 

If this project is taken forward for further appraisal it is recommended that consultation is focused 
on, but not limited to, the following: 

• Residents in the area at risk 

• Landowners and developers for the upstream storage option. 

• Riparian landowners, especially owners of riverside walls acting as informal defences 

1.7 Economic summary and preliminary preferred opti on 
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Table 1.4 summarises the economic assessment carried out for all options. The calculations for 
PV benefits are shown in Appendix D. The options are ordered by the assumed benefits (lowest 
benefit first). 

This benefit values are estimates based on the methodology detailed in Appendix C. There is 
significant uncertainty in these estimates, which are based on Weighted Annual Average Data 
(WAAD) from the Multi-Coloured Manual (MCM, 2015/16). If this project progresses to further 
appraisal the benefits of these options should be more accurately assessed though hydraulic 
modelling and use of the more detailed flood depth / damage data from MCM.  

 
 
 
 
 
 
 
 
Table 1.4 Benefit-cost assessment  

 PV costs  
(£k) 

PV benefits 
(£k) 

Av. 
BCR 

Incr’ 
BCR 

Option for iBCR  
calc  

Comments 

Do 
Minimum 

30 
Low   1,222 
Mid    1,630 
High  2,037 

37.1 
49.4 
61.7 

- - Highest ABCR 

Option 1 1,060 
Low   1,456 
Mid    1,941 
High  2,426 

1.4 
1.8 
2.3 

0.2 
0.3 
0.4 

Do Minimum 
1.3% (1 in 75 year) AEP SoP 

Option 3 4,660 
Low   1,475 
Mid    1,966 
High  2,458 

0.3 
0.4 
0.5 

0.1 
0.1 
0.1 

Do Minimum 
1% (1 in 100 year) AEP SoP 

Option 6 10,190 
Low   1,456 
Mid    1,941 
High  2,426 

0.1 
0.2 
0.2 

0.0 
0.0 
0.0 

Do Minimum 
1.3% (1 in 75 year) AEP SoP 

The Do Minimum scenario has the highest ABCR justifying the continuation of the current 
maintenance regime. 

There are insufficient data on the existing surface water assets to be able determine the existing 
flood risk for Option 2, therefore the benefit-cost assessment has not be completed as part of this 
study but should be considered in future studies. 

The upstream storage options on the River Aire (Option 5) and River Worth (Option 4) will 
provide a reduction in flood risk beyond in Apperley Bridge and beyond the study boundaries for 
this Initial Assessment.  As a result the benefit-cost ratio for the option will be artificially low, being 
limited to the Apperley Bridge benefits.  Therefore the economic analysis for the option is not 
presented in this report but the option should be considered in any future studies. 

Option 1, Property Level Protection, is the only other option with an ABCR greater than parity.  
The option can be carried forward to the next stage however it is not eligible for FDGiA funding.  
The Flood and Coastal Resilience Partnership Funding (EA) document states that property level 
protection can be funded under OM2 if they are within the very significant risk category.  There 
are no residential properties in the very significant category in Apperley Bridge therefore the 
option will need to be wholly funded by another funding stream e.g. local levy funding. 

1.7.1 Funding and contributions 

Due to the FDGiA funding rules option 1 is not eligible for GiA funding. Other potential funding 
sources identified include: 
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• Community Infrastructure Levy 

• Benefitting local businesses 

• Council Tax 

• Local Enterprise Partnerships 

1.7.2 Key delivery risks (economic, social and envi ronmental) 
Key delivery risk and recommendations for mitigating these risks are shown in the table below. 
 
 
Table 1.5 Risks and mitigation  

Risk Key Mitigation 
Insufficient 3rd party Funding available to allow 
scheme to progress 

Assess potential funding options before 
progressing scheme appraisal further. 

Uncertainty in benefits estimates 
More detailed assessment of the benefits 
should be undertaken if the site moves 
forward to further appraisal. 

Uncertainty in costs 
More detailed assessment of the costs 
should be undertaken if the site moves 
forward to further appraisal. 

 
 
 

1.8 Project Scoring 

The data used in this assessment has been subjected to a RAG assessment. RAG status 
reporting is used to indicate the level of confidence in the data used in each aspect of the 
assessment, using the traffic light system. This gives a three figure score with the first number 
being the number of reds (showed as a letter R)), where there is significant uncertainty or 
challenges. The second and third numbers are the numbers of amber (A) and greens (G). The 
results are shown below: 

• A – Problem Definition:  The fluvial and surface water flooding mechanisms are well 
understood but no hydraulic modelling data has been used in the assessment – 
AMBER  

• B – Economic Case: The benefits assessment has been based on moving properties 
from flood risk bands and weighted average annual damages – RED 

• C – Funding:  The options are likely to require external funding.  Alternative funding 
sources have been identified – AMBER  

• D – Engineering case:  Solutions taken to outline design and are tried and tested 
defence options – AMBER  

• E – Permissions & Consents:  Solution are unlikely to require unusual permissions or 
consents – GREEN 

• F – Environmental sensitivities: Initial environmental assessments has been 
completed based on outline options – AMBER  

• G – Opportunities: Some potential opportunities for partnership working but minimal 
environment opportunities – AMBER  

Model. Econ. Funding Eng. Permission  Env. RAG Opps. 
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A B C D E F G 
2 3 2 2 1 2 141 2 

 

1.9 Further work requirements 

If the project is taken forward for further appraisal it is recommended that the following work is 
carried out before the SOC is developed : 

• Further investigation in Option 2 – Improvements to urban drainage.  Work will involve 
the complete of asset and condition survey of existing surface water network.  Once 
the network has been survey it would be possible to identify the causes of the surface 
water flooding and propose mitigation measures. 

• Investigate the impacts of upstream storage options proposed by the Leeds Phase 2 
PAR and Upper Aire SFRA.  The findings should be used to review and update the 
economic assessment.  

• Option 6 – upstream storage will have benefits outside of the study area.  Hydraulic 
modelling of this option should be carried out to assess if the changes in downstream 
water level potentially provide additional benefits. 

 
 

1.10 Conclusions and Recommendation 

Based on the evidence provided, it is understood the main risk of flooding within Apperley Bridge 
is fluvial from the overtopping of river banks along both the River Aire and Carr Beck and surface 
water flooding, the existing flood risk is moderate to high.  There was significant flooding in the 
area during Boxing Day 2015 from Carr Beck.   Anecdotal evidence also suggests that there is a 
significant risk of surface water flooding which needs to be investigated in future. 

The economic analysis shows that the Do Minimum scenario is beneficial and that the current 
maintenance regime should be continued.  The current maintenance regime is simply a bi-annual 
site walkover, one in the summer and one in the winter to identify ad-hoc channel works.  No 
regular channel works are carried out. 

Option 1, property level protection is the highest scoring Do Something option, however due the 
funding rules is unable to gain any FDGiA funding. 

It is recommended that the flood storage options are considered further in a wider strategic 
assessment as they could benefit a large areas on the Upper Aire. 


